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1
日本ポジティブリスト制度の概要

2005 年 11 月 29 日、厚生労働省によって、残留農薬、飼料添
加物、および動物用医薬品を規制するための「ポジティブリスト」
制度が告示されました。 

この告示では、農薬等 758 品目に対する暫定の最大残留基準値
（MRL）が発表され、65 品目が規制免除の対象として指定されま
した。人体に影響を及ぼす恐れが高いために食品における残留が
一切認められていない農薬等は、15 種類あります。この「ポジ
ティブリスト」制度の下では、リストに含まれている農薬等のみ
を農産物で使用することが許可され、その残留量が日本政府に
よって定められた MRL に適合していることが義務付けられてい
ます。基準値の記載がない農薬等の MRL は、一律 0.01 ppm で
す。この新規制は 2006 年 5 月 29 日に施行されました。

実際の MRL 値は、最終的な MRL が反映されたリストと暫定的な
MRL が含まれたリストという、2 つのリストに記載されていま
す。2007 年 2 月 5 日、これら両方の MRL リストの改訂版が厚
生労働省によって公開されました。改訂版の暫定リストには、67
品目の新しい薬品と農薬が追加されました。 

当初の日本ポジティブリストに含まれていた農薬のうち、265 品
目が GC/MS による分析対象に指定されましたが、新しく追加さ
れた農薬 59 品目の多くも GC/MS 分析の対象に指定することが
可能です。

付録 I には、日本ポジティブリスト制度について詳しく説明した
参考資料や Web サイト（英語）へのリンクが掲載されています。
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2
デコンボリューションレポート作成
ソフトウェア（DRS）

Agilent のデコンボリューションレポート作成ソフトウェア
（DRS）は、質量スペクトルデコンボリューションを従来のライブ
ラリ検索機能および定量機能と組み合わせたソフトウェアです。
DRS では、次の 3 種類の GC/MS ソフトウェアパッケージから得
られた結果を組み合わせて、レポートが生成されます。1）Agilent
GC/MS ChemStation、2）米国標準技術局（NIST）の質量スペクト
ル検索プログラムおよび NIST05 MS ライブラリ、3）NIST の自
動質量スペクトルデコンボリューション同定システム（AMDIS）ソ
フトウェア。 

デコンボリューションの原理と Agilent DRS ソフトウェアの機
能について説明した資料は多数あります。これらの資料は、DRS
ソフトウェアの CD、日本ポジティブリスト農薬ライブラリの
CD、および Agilent の Web サイト（www.agilent.com/chem/jp）
にあります。NIST 質量スペクトルライブラリ、DRS ソフトウェ
ア、および農薬ライブラリのインストールに進む前に、上記の場
所にある参照資料に目を通して、DRS に慣れ親しんでおく必要が
あります。 
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2 デコンボリューションレポート作成ソフトウェア（DRS）
 

日本ポジティブリスト農薬データベースの内容

日本農薬データベースに含まれている農薬は、3 つの原典から取
得されています。まずは、厚生労働省による現行の規制下で
GC/MS による分析対象に指定されている農薬です。また、神戸検
疫所と横浜検疫所の分析者によって最近報告された農薬も追加
されました。3 つ目の原典は、厚生労働省食品案全部の「2006 年
度輸入食品監視指導計画」です。この計画では、輸入された食品
と農産物が、447 種類の農薬を列記した同文書の「リスト 6 に
準拠」したものでなければならないことが定められています。リ
ストの 447 農薬の中には、GC による分析に適したものもあれ
ば、LC による分析に適したものもあります。一部の農薬はいず
れの方法で分析することも可能ですが、この文書にはどちらの分
析法を用いるべきかに関する規定がありません。そのため、
Agilent の日本ポジティブリスト農薬データベースには、リスト
6 の化合物のうち、GC/MS による分析が実際的であると判断され
るものがすべて含まれています。参照資料およびその Web リン
クは、付録 I に記載されています。 

DRS データベースと質量スペクトルライブラリには、合計 431
種類の化合物（農薬 430 種および内部標準物質 1 種）が含まれ
ています。DRS 農薬ライブラリの CD には、次の項目が収録され
ています。

･ Agilent GC/MS ChemStations で使用する従来の質量スペクト
ルライブラリ（Japanpest_1.L）

･ GC/MS ChemStation に統合された Agilent の強力なスクリー
ナソフトウェアで使用するスクリーナデータベース

（Japanpest_1.scd）

･ Agilent GC/MS ユーザーが各自の実験室で再現できる 430 農
薬のロックリテンションタイム

･ Agilent の G1716AA（A.03.00）デコンボリューションレポート
作成ソフトウェアで使用するファイル（Japanpest_1.msl など）

･ 日本ポジティブリストメソッドを使用してデータを取り込む
ための ChemStation メソッド（JAPANPest_6890.M、
JAPANPest_2uLSL.M、RG_JAPANPest_2uLSL.M、および
QS_RG_JAPANPest_2uLSL.M）。これらのメソッドのパラメータ
は、第 4 章「GC/MS メソッドの設定」の表 1 に記載されてい
ます。

･ サンプルファイル

･ アプリケーションメモ
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3
ソフトウェアのインストール

ソフトウェア要件

DRS を日本ポジティブリスト農薬データベースと共に実行する
には、次のソフトウェア製品を正しい順序でインストールする必
要があります。正しいインストール順序は次のとおりです。

1 Agilent MSD ChemStation（バージョン E.01.00 以上）

2 NIST 質量スペクトルライブラリ（NIST05）、NIST 質量スペク
トル検索プログラム、および AMDIS（バージョン 2.64）[3 つ
のプログラムはすべて NIST05 質量スペクトルライブラリの
ディスクに収録 ]

3 DRS（バージョン A.03.00 以上）

4 日本ポジティブリスト農薬データベース
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3 ソフトウェアのインストール
 

Agilent GC/MS ChemStation のインストール

Agilent GC/MS ChemStation バンドルを購入した場合、GC/MS
ChemStation は既に PC にインストールされています。その場合
は、1 台の機器を拡張モードでコンフィグレーションしてから、
NIST 質量スペクトルライブラリ、NIST 質量スペクトル検索プロ
グラム、および AMDIS のインストールに進むことができます。

ChemStation をインストールするには、Agilent GC/MS 
ChemStation ソフトウェア CD を挿入して、ソフトウェアイン
ストールの指示に従います。ChemStation は、デフォルトで 
C:\msdchem にインストールされます。

DRS ソフトウェアは拡張モードの機器としか連動しないので、
4 つの機器のうち少なくとも 1 つを拡張モードでコンフィグ
レーションする必要があります。Windows の [ スタート ] メ
ニューから [ すべてのプログラム ] > [MSD ChemStation] > 
[Config] の順に選択して、機器コンフィグレーションプログラム

を起動します。

コンフィグレーションする機器をクリックして（この場合は
[2]）、機器に関する情報を入力します。データ解析モードとして
[Enhanced] を選択し、次の図に示す情報ではなく、お使いの GC
および MSD の正しい IP アドレスを入力してください。
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[OK]、[Yes] の順にクリックして、コンフィグレーションを新し

い機器で更新します。
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3 ソフトウェアのインストール
 

新しい機器（日本農薬 GC-MS）がコンフィグレーション済み機器
のリストに追加されます。

Agilent MSD コンフィグレーションソフトウェアを閉じます。

[ スタート ] > [ すべてのプログラム ] > [MSD ChemStation] > 
[Instrument #2] > [Japanese Pesticide GC-MS Data Analysis] の順に

クリックして、ChemStation を開きます。データ解析システム
が読み込まれ、拡張モードでコンフィグレーションされている
ことを確認します（注 : パス、機器番号、および機器名は図と
異なる場合があります）。
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他のソフトウェアをインストールする前に、ChemStation を閉じ
ます。
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3 ソフトウェアのインストール
 

NIST05 質量スペクトルライブラリ、NIST 質量スペクトル検索
プログラム、および AMDIS のインストール

NIST 質量スペクトルライブラリの CD を挿入して、NIST05 質量
スペクトルライブラリのインストール手順に従います。初期設定
の後で、次の図の画面が表示されます。[Install NIST Library Search
Program and AMDIS] チェックボックスがオンになっていること
を確認します。[Finish] をクリックします。

NIST05、NIST ライブラリ検索プログラム、および AMDIS をインス
トールすることを確認する、次の図の画面が表示されます。他の
プログラムを閉じたことを確認して、[Next] をクリックします。
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次の図の画面が表示されたら、[Typical]、[Next] の順にクリック

します。



18 デコンボリューションレポート作成ソフトウェアガイド

3 ソフトウェアのインストール
 

NIST05 MS ライブラリと AMDIS のデフォルトディレクトリが次
の画面に表示されます。デフォルトディレクトリを受け入れて、
[Next] をクリックします。
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Agilent GC/MS ChemStation では、NIST ライブラリ検索プログ
ラムと Agilent PBM 検索プログラムのどちらでもデフォルトと
して設定できます。ただし、PBM ライブラリ検索の方が高速で、
大半の GC/MS ユーザーにとって使い慣れた内容になっていま
す。いずれかのプログラムをデフォルトとして、後でそれを変更
することもできます。これを行うには、データ解析システムのド
ロップダウンメニューで [Spectrum/Set Default Search Engine] を
クリックします。
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3 ソフトウェアのインストール
 

処理が完了すると、Agilent 形式の NIST ライブラリが 
C:\Database\NIST05.L にインストールされます。次に、NIST 形
式の NIST ライブラリと NIST 検索エンジンが C:\NIST05\
MSSEARCH にインストールされ、AMDIS が C:\NIST05\AMDIS32 に
インストールされます。

データ解析システムを開いて、NIST と AMDIS のインストールを
確認します。

DRS をインストールする前に、データ解析システムを閉じます。

注意 NIST の Web サイトからダウンロードしたバージョンの AMDIS
は、お使いの DRS リビジョンとの互換性がない可能性があるの
で使用しないでください。
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GC/MS 向け DRS のインストール

ChemStation を含め、すべてのプログラムを閉じます。DRS ソフト
ウェアが収録された CD を挿入して、指示に従います。インストー
ルが完了したら、GC/MS ChemStation データ解析ソフトウェアを開
きます。[DRS] という新しいメニュー項目が表示されます。

注記 DRS をインストールする前に、Agilent GC/MS ChemStation、
NIST05 質量スペクトルライブラリ、AMDIS、および NIST ライブ
ラリ検索プログラムをインストールしておく必要があります。
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3 ソフトウェアのインストール
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日本ポジティブリスト農薬データベース（Japanpest_1.L、
Japanpest_1.msl など）のインストール

日本ポジティブリスト農薬ライブラリをインストールする前に、
Agilent GC/MS ChemStation、NIST05 質量スペクトルライブラ
リ、AMDIS、NIST 質量スペクトル検索プログラム、およびデコン
ボリューションレポート作成ソフトウェアが既にインストール
されていることを確認します。

日本ポジティブリスト農薬データベースが収録された CD を挿
入して、インストール手順に従います。
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4
GC/MS メソッドの設定

日本ポジティブリストメソッドを使用した農薬分析用の GC/MS
メソッドは、2 とおりの方法で設定できます。そのうちの 1 つ
である、簡単な方の方法は、日本ポジティブリストデータベース
と共にインストールされたメソッドのいずれかを使用すること
です。もう 1 つの方法は、メソッドに関するすべてのパラメー
タを入力して、リテンションタイムロック用の較正ファイルを独
自に取得することです。どちらのアプローチについても以下で説
明します。
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コンフィグレーションに適したメソッドの選択

お使いの GC/MS のコンフィグレーションに応じて、4 種類のメ
ソッドのいずれかをインストールできます。いずれのメソッドに
もリテンションタイムロックデータが割り当てられており、日本
ポジティブリスト農薬データベースに含まれている農薬のリテ
ンションタイムを再現できるようになっています。以下に、メ
ソッド名を示し、そのメソッドが指定されている機器コンフィグ
レーションについて簡潔に説明します。

JAPANPest_6890.M このメソッドは、スプリット / スプリット
レス注入口と MSD 間を 30 m × 0.25 mm × 0.25 μm DB-5MS
カラムで接続するようにコンフィグレーションされた Agilent
6890N/5973 GC/MSD システム上で開発されました。このメソッド
は、6890 GC を 5973 または 5975 MSD システムと併用する場合
に使用します。

JAPANPest_2uLSL.M このメソッドは、スプリット /スプリット
レス注入口と MSD 間を 30 m × 0.25 mm × 0.25 μm DB-5MS カ
ラムで接続するようにコンフィグレーションされた 7890A/5975
GC/MS 向けに開発されました。

RG_JAPANPest_2uLSL.M このメソッドは、5 m × 0.25 mm のリ
テンションギャップに 30 m × 0.25 mm × 0.25 μm DB-5MS カ
ラムを接続するようにコンフィグレーションされた 7890A/5975
GC/MS 向けに開発されました。リテンションギャップは、スプ
リット / スプリットレス注入口と MSD のカラム終端に取り付け
られます。

QS_RG_JAPANPest_2uLSL.M このメソッドは、30 m × 0.25 mm
× 0.25 μm DB-5MS カラムに QuickSwap と 5 m × 0.25 mm リ
テンションギャップを接続するようにコンフィグレーションさ
れた 7890A/5975 GC/MS 向けに開発されました。リテンション
ギャップはスプリット / スプリットレス注入口に取り付けられ、
カラム終端は QuickSwap に接続されます。付録 II では、この
メソッドで QuickSwap を使用することによってもたらされるメ
リットについて説明します。QuickSwap を取り付けた場合は、感
度が多少低下することに注意してください。
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日本ポジティブリスト農薬メソッドの読み込み

以下の説明では、7890A GC システムが 5973 または 5975 MSD と
共に取り付けられていることを前提としています。7890A GC 向
けの Agilent GC/MS ChemStation ソフトウェアは、7890A の新
機能を反映させるために、6890 向けのソフトウェアと多少異な
る内容になっています。6890 ベースの GC/MS システムをお使い
の場合、実際の画面に表示される内容は、以下の説明またはスク
リーンキャプチャと異なることがあります。

日本ポジティブリスト農薬データベースのインストールでは、
4 つのメソッド（JAPANPest_6890.M、JAPANPest_2uLSL.M、
RG_JAPANPest_2uLSL.M、および QS_RG_JAPANPest_2uLSL.M）が 
C:\MSDChem\MSDemo\Pesticide Example Methods フォルダに配
置されました。各メソッドはフォルダになっており、これらの
フォルダには GC/MS メソッドを構成する多数のファイルが保存
されています。

以下の説明では、JAPANPest_2uLSL.M というメソッドを使用す
るために選択したものと仮定します。このフォルダ

（JAPANPest_2uLSL.M）を GC/MS 機器のメソッドフォルダにコ
ピーしてください。たとえば、機器 1 を使用して農薬分析を行
う場合は、メソッドフォルダ（JAPANPest_2uLSL.M）を 
C:\MSDChem\1\Methods に配置します。これは、リテンションタ
イムロック（RTL）較正ファイルが既に含まれた、RTL メソッド
の 1 つです。メソッドのロックプロセスおよび再ロックプロセ
スについては、第 5 章「リテンションタイムロッキング」で説
明します。
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日本ポジティブリスト農薬ライブラリに付属したメソッドの
読み込み

ChemStation 機器コントロールソフトウェアを開いて、[Method] >
[Load Method] の順にクリックし、JAPANPest_2uLSL.M というメ

ソッドを選択します。

お使いの機器がこのメソッドの作成に使用した機器と異なるコ
ンフィグレーションになっている場合は、機器コントロールソフ
トウェアの [GC Edit Configuration] および [GC Edit Parameters]
で、必要に応じて差異を解決する必要があります。
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機器のコンフィグレーションに差異があるかどうかにかかわら
ず、機器パラメータをすべてチェックして、パラメータが表 1 の
内容 に対応 して いる ことを 確認 する必 要が ありま す。
JAPANPest_2uLSL.M を読み込んだ後で [GC Edit Parameters] ウィ
ンドウが自動的に開かない場合は、次の図に示す [GC column] ア
イコンをクリックします。これによって、前の図のような [GC
Edit Parameters] ウィンドウが表示されます。
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機器のコンフィグレーションをチェックして、機器のコンフィグ
レーションとメソッドのコンフィグレーションが一致している
ことを確認します。機器のコンフィグレーションに変更を加える
には、[Instrument] > ［GC Edit Configuration］ の順にクリックしま
す。これにより、カラムの取り付け、シリンジサイズの選択、キャ
リアガスタイプの設定などを行えるようになります。
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次の図のウィンドウは、GC コンフィグレーションエディタの
[Columns] タブが表示されています。各タブの設定をチェックし
て、コンフィグレーションが使用中のメソッドに対して正しいこ
とを確認してください。
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次に、金色の四重極アイコンを左クリックして、MSD パラメータ
をチェックします。金色の四重極アイコンを右クリックして
[Select MS Tune File] をクリックし、使用するチューニングファイ

ルを選択します。日本ポジティブリスト農薬ライブラリは、
Agilent の自動チューニングファイル Atune.u を使用して生成
されています。また、ライブラリに付属のメソッドでも Atune.u
が指定されます。
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微量イオン検出

微量イオン検出とは、プロプライエタリな質量スペクトルデータ
フィルタリング技術のことです。この技術を導入すると、バック
グラウンドノイズの削減、ピーク形状の改善、質量スペクトルラ
イブラリ一致率の向上、DRS を使用した検出下限の低下などのメ
リットがもたらされます。微量イオン検出はオプションの機能で
すが、有効にしておくことが推奨されます。データ取込システム
で、次の図のウィンドウに示すように、[Instrument] > [Trace Ion
Detection...] の順に選択します。

これによって、[Activate Trace Ion Detection] ウィンドウが表示さ
れます。次の図に示すチェックボックスをオンにして、[OK] を
クリックします。
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メソッドの再ロック

ソフトウェアに付属の 4 つのメソッドのうちいずれかをインス
トールしてある場合は、リテンションタイムロック用の較正ファ
イルが既に用意されています。クロルピリホスメチルが含まれた
サンプルを注入して（5 ng が適量）、リテンションタイムを特定
します。カラム流量を微調整して、リテンションタイムがロック
リテンションタイムの 0.2 min 内に収まるようにします

（13.443 min ± 0.2 min）。

データ解析システムに移動し、第 5 章「リテンションタイムロッ
キング」の説明に従ってメソッドを再ロックします。
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Agilent 提供のメソッドに含まれている較正テーブルに関する
注記

日本ポジティブリスト農薬データベースに付属の 4 つの各メ
ソッドには、430 種類の農薬および 1 種類の内部標準物質（フェ
ナントレン -d10）に関する較正テーブルが含まれています。平均
感度係数は、ターゲット化合物ごとに設定されています。これは、
Agilent 応用研究所の GC/MSD システムで取得された約 25 種類
の農薬の感度を平均したものです。どの化合物にも同じ平均感度
係数が割り当てられています。したがって、この係数を使用して
計算された値は推定値にすぎません。

未較正の DRS を使用すると必ず化合物が検出されるので、これ
らの値は事前に定義されています。新しい化合物が検出されるた
びに、「どのぐらいの量が存在するか」という疑問が生じます。こ
れらの感度係数を使用すると、「概算的」に量を見積もることが
できます。正確な定量のためには、較正標準を注入することに
よってシステムを較正する必要があります。
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GC/MS パラメータの手動入力

次の表は、日本ポジティブリストメソッドをスキャンモードで使
用して農薬分析を行う場合の GC/MS 計測器と設定値を示したも
のです。メソッド作成のための 2 番目の代替方法として、表 1
の設定値を手動で入力することもできます。

表 1 日本ポジティブリスト制度に基づく農薬分析のための計測器および分析条件

ガスクロマトグラフ Agilent 7890A

カラム Agilent J&W 30 m × 0.25 mm × 0.25 μm DB-5MS（パーツ番号 
122-5532）

リテンションギャップ
（オプション）

5 m × 0.25 mm Siltek 不活性化フューズドシリカチュービング
（Restek パーツ番号 10026）

キャリアガス ヘリウム。リテンションギャップなしの場合の公称流量は 1.0 mL/min。
5 m × 0.25 mm のリテンションギャップが GC カラムのヘッドに接続
されている場合は約 1.1 mL/min。5 m × 0.25 mm のリテンション
ギャップが GC カラムのヘッドに接続され、QuickSwap が取り付けら
れ、圧力 5.2 psi（35.9 kPa）に設定されている場合は約 1.7 mL/min

リテンションタイムロッキング 13.443 分にロックされたクロルピリホスメチル

オーブン温度プログラム 50 ℃（1 分）、25 ℃ /min ～ 125 ℃（0 分）、10 ℃ /min ～ 300 ℃（10 
分）

注入口 スプリット /スプリットレス

注入口温度 250 ℃

注入口ライナー Helix ダブルテーパー不活性化（パーツ番号 5188-5398）

使用する内部標準物質 フェナントレン -d10（5 ng/83 μL）

オートサンプラ Agilent 7683B シリーズインジェクタおよびトレイ

注入量 2 μL

マススペクトロメータ Agilent 5975C MSD

取込モード スキャン

スキャン範囲 45 ～ 550 u
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しきい値 0（またはノイズレベルに基づいて設定）

サンプリングレート n = 2

トランスファライン温度 280 ℃

溶媒待ち時間 3.5 分

イオン源温度 230 ℃

四重極温度 150 ℃

チューニングファイル Atune.u 

微量イオン検出（TID） オン

ソフトウェア

GC/MS 機器コントロール Agilent G1701EA GC/MS ChemStation（バージョン E.01.00 以上）

デコンボリューションレポート
作成ソフトウェア

Agilent パーツ番号 G1716AA（バージョン A.03.00 以上）デコンボ
リューションレポート作成ソフトウェア

ライブラリ検索ソフトウェア NIST MS 検索（バージョン 2.0d 以上）（NIST05 質量スペクトルライブ
ラリ Agilent パーツ番号 G1033A に付属）

デコンボリューションソフト
ウェア

自動質量スペクトルデコンボリューション / 同定ソフトウェア
（AMDIS_32 バージョン 2.64、NIST05 質量スペクトルライブラリ 
Agilent パーツ番号 G1033A に付属）

MS ライブラリ NIST05 質量スペクトルライブラリ（Agilent パーツ番号 G1033A）
Agilent 日本ポジティブリスト農薬ライブラリ（Agilent 形式および 
NIST 形式）（パーツ番号 G1675AA）

表 1 日本ポジティブリスト制度に基づく農薬分析のための計測器および分析条件 (continued)
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5
リテンションタイムロッキング

リテンションタイムロッキング（RTL）機能を使用すると、日本
ポジティブリスト農薬データベースでリテンションタイムを再
現できます。この機能を使用するには、30 m × 0.25 mm × 
0.25 μm の DB-5MS カラムを取り付けて、第 4 章「GC/MS メソッ
ドの設定」で説明する条件を設定する必要があります。流量を
1.0 mL/min に設定して（リテンションギャップと QuickSwap を
使用しないことを想定）、クロルピリホスメチルが含まれたサン
プルを注入します。クロルピリホスメチルのリテンションタイム
は、目標値である 13.443 分に近くなるはずです。リテンション
ギャップや QuickSwap を使用する場合は、流量をこれより高く
する必要があります。推奨値は、第 4 章の表 1 に示すとおりで
す。ロックする RT（13.443 分）の ± 0.2 分以内に収まったら、
次の手順に従ってメソッドをロックする必要があります。

1 クロルピリホスメチルが含まれたサンプルを約 5 ng/83 μL 
の濃度で作成し、このサンプルが含まれた 2 mL オートサンプ
ラバイアルをオートサンプラのポジション 1 に配置します。

2 データ取込システムで、次の図に示すように [Method] > 
[Acquire RTLock Calibration Data] をクリックします。
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次の図のメッセージが表示されます。
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[Yes] をクリックして続行します。

次の図のメッセージが表示されます。[Yes]、[OK] の順にクリッ
クします。クロルピリホスメチルの含まれたサンプルがオートサ
ンプラのポジション 1 に配置されていることを確認します。
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3 GC/MS によって以下の 6 回の注入が自動的に行われます。

a 1 回目 : カラムをクリーニングするため（この分析は保存
されません）

b 2 回目 : カラムヘッド圧は公称値 -20%

c 3 回目 : カラムヘッド圧は公称値 -10%

d 4 回目 : カラムヘッド圧は公称値

e 5 回目 : カラムヘッド圧は公称値 +10%

f 6 回目 : カラムヘッド圧は公称値 +20%

定流量モードで作業している場合でも、カラムヘッド圧は RT
ロッキングプロシージャによって調整されます。最終的には、
RTL ソフトウェアによってカラムヘッド圧の正しい開始値が
決定され、クロルピリホスメチルのリテンションタイムを
13.443 分にロックするための正しい定流量が定められます。

4 6 回の GC/MS 分析が終わると、ChemStation データ解析シス
テムの新しいセッションが開き、（公称カラムヘッド圧で取得
された）クロマトグラムが表示されます。ウィンドウの下部
に、右マウスボタンをクリックしたままで、メソッドのロック
に使用されるピークの下までマウスをドラッグするように求
めるメッセージが表示されます。標準サンプルによっては、
ピークが 1 つ（クロルピリホスメチル）の場合と、次の図に
示すようにクロルピリホスメチル以外にもピークがある場合
があります。
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ピークを右マウスボタンでダブルクリックすると、下のウィン
ドウにスペクトルが表示され、正しいピークが選択されたこと
を確認できます。左マウスボタンを使用してズームインするこ
ともできます。マウスのポインタをクロルピリホスメチルの
ピークの片側に置き、右マウスボタンをクリックしたまま、
ピークの反対側までマウスをドラッグします。マウスボタンを
離します。

Click/Drag RIGHT Mouse to select the Peak for Automatic Lock Calculations 

Chlorpyrifos-methyl 



46 デコンボリューションレポート作成ソフトウェアガイド

5 リテンションタイムロッキング
 

5 他のクロマトグラムのピークを検出するかどうかを問うメッ
セージが表示されます。[Yes] をクリックして続行します。

クロルピリホスメチルのピークが残りのクロマトグラムで見
つけられ、次の図に示すように、5 つのクロマトグラムすべて
がウィンドウに表示されます。クロルピリホスメチルの RT と
カラムヘッド圧のグラフに使用する最適な曲線近似が決定さ
れます。曲線近似の等式が相関係数（この場合は 0.999553）
と共に表示されます。[Yes] をクリックして設定を続行します。



リテンションタイムロッキング 5

デコンボリューションレポート作成ソフトウェアガイド 47

 

6 次の図のウィンドウにロッキング化合物の名前を入力します。
[OK] をクリックして続行します。
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7 5 つの GC/MS データファイルをメソッドと共に保存するかど
うかを問うメッセージが表示されます。ファイルを保存しなく
ても、較正曲線は維持されるので、何らかの理由で RT が変化
した場合にメソッドを再ロックすることができます。通常、こ
れらのファイルは保存されます。[Yes] をクリックして続行し
てください。

8 クロルピリホスメチルのターゲットリテンションタイムを入力
します。ターゲットリテンションタイムとは、メソッドをロッ
クしたときにクロルピリホスメチルのリテンションタイムとす
べき値です。この場合は 13.443 分にする必要があります。
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9 クロルピリホスメチルの RT を 13.443 分に移動する、正しい
初期カラムヘッド圧が決定されます。この新しいカラムヘッド
圧によって、目標値（13.443 分）のプラスマイナス数千分の
1 分の範囲にリテンションタイムが移動します。[Yes] をク
リックして、この新しい値をメソッドに保存します。メソッド
によっては、カラムヘッド圧が次の図の値と大きく異なる場合
があります。このメソッドを作成するために使用された機器
は、5 m のリテンションギャップと QuickSwap を使用してコ
ンフィグレーションされたものです。

定流量モードが有効になっているため、このカラムヘッド圧を
適用することによって、実行中常に一定の流量が生成されま
す。実行中にオーブン温度が上昇すると、定流量を維持するた
めにカラムヘッド圧も上昇します。

10 この自動プロセスが終了すると、次の図のウィンドウは開いた
ままになります。通常は、ドロップダウンメニューの [View] >
[Return to Data Analysis] をクリックします。自動アプローチに
よって選択されたピークを使用しない場合は、5 つの各クロマ
トグラムで希望のピークを手動で選択し、説明に従って処理を
続行することもできます。通常、この操作は必要となりません。
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11 新しいカラムヘッド圧と流量でメソッドを再読み込みします。
次に、クロルピリホスメチル標準サンプルを 1、2 回注入し
て、クロルピリホスメチルの RT がロッキング値のプラスマイ
ナス 0.03 分以内（13.443 ± 0.03 分）に収まっていること
を確認します。RT がこの範囲内にない場合、またはリテンショ
ンタイムをターゲット値にさらに近づける必要がある場合は、
以下の説明に従ってメソッドを再ロックします。

Click/Drag RIGHT Mouse to Select Peak for Manual Lock Calculations 
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メソッドの再ロック

GC/MS メソッドの再ロックが必要となる理由はいくつかありま
す。たとえば、ChemStation ソフトウェアで Agilent のリテン
ションタイムロッキング機能を使用して、すべての化合物のリテ
ンションタイムを元の値に戻す場合などがそれに相当します。日
本ポジティブリスト農薬ライブラリに付属の 3 つのメソッドの
うちいずれかをインストールした場合は、そのメソッドに用意さ
れた較正データを使用して、メソッドを再ロックする必要があり
ます。リテンションタイムが移動したり、日常的なメンテナンス
の一環として GC カラムを切断したりした場合は、メソッドを再
ロックすることによって、ライブラリ値に非常に近い値にリテン
ションタイムを維持することができます。

データ解析システムで、[View] > [RTLock Setup] をクリックしま
す。これによって、リテンションタイムロッキングウィンドウが
開き、較正ファイルが表示されます（5 つの異なるカラムヘッド
圧で行われた 5 回の注入を反映）。  

次の図に示すように、[RTLock] > [Re-Lock Method...] を選択します。
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現在の条件で分析するロッキング化合物（クロルピリホスメチ
ル）のデータファイルを選択するように求めるメッセージが表示
されます。次の図に示すように、ファイルツリー内を移動して、
最近行ったクロルピリホスメチル注入のデータファイルを見つ
けます。この場合のファイル名は TM-2A_3.D です。[OK] をク
リックします。

RTLock 

Re-Lock Method 
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クロマトグラムのピークがリテンションタイムと共に一覧で表
示されます。クロルピリホスメチルのピーク（次の図の 13.461
分の位置にあるピーク）を選択して、[OK] をクリックします。
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これ以降の手順は、この章の冒頭で説明したステップ 8 ～ 11 と
まったく同じです。
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6
メソッドコンフィグレータの設定

ChemStation データ解析ソフトウェアで、[DRS] ドロップダウン
メニューの [Method Configurator] を選択します。これによって、
DRS ソフトウェア内の、各 DRS メソッドに関連した特定のパラ
メータを指定する画面が表示されます。次の図のウィンドウに
は、DRS_Demo のメソッドパラメータが表示されています。ポジ
ティブリスト農薬メソッドのパラメータを編集する場合は、
[Method Association Settings] > [Edit Settings] をクリックします。
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選択ボックスの下矢印をクリックして、JAPANPest_2uLSL.M とい
うメソッドを選択し、[OK] をクリックします。

表示されたウィンドウでは、メソッドのさまざまなパラメータを
編集できます。通常は、表示された AMDIS ターゲットライブラ
リ、つまり Japanpest_1.msl を使用します。このライブラリが
表示されない場合、または別のライブラリに変更する必要がある
場合は、選択ボックスの参照ボタンをクリックして、使用するラ
イブラリを選択します。通常、AMDIS ライブラリは、59 ページ の
図に示すように C:\NIST05\AMDIS32\LIB に保存されています。
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RI 較正データファイルは、常に図に示すファイルになります。そ
のため、他のファイルを指定することはできません。チェック
ボックスをオンまたはオフにして、このファイルを使用するかど
うかを選択する必要があります。図に示すようにチェックボック
スをオンにすると、農薬を同定する際にリテンションタイムが必
須要件として使用されるようになります。これについては、第 8
章「AMDIS 設定」で詳しく説明します。

デフォルトの AMDIS 初期化設定ファイルは Onsite.ini です。
このファイルには、デコンボリューションメソッドによって使用
される AMDIS 設定が保存されています。サンプルごとに異なる
AMDIS 設定を使用することもできますが、ini ファイルに新しい
名前（User.ini や Bananas.ini など）を付けて保存する場合は
注意が必要です。User.ini ファイルは、[Analyze] > [Settings]
> [Save As...] を選択し、新しい名前を付けることによって、
AMDIS で作成されるファイルです。これらのファイルは通常、マ
トリクス固有またはサンプル固有の AMDIS 設定で使用されま
す。user.ini ファイルは、メソッドコンフィグレータで指定さ
れ、 DRS の実行時に onsite.ini と結合して、それを上書きしま
す。つまり、AMDIS が常に使用する ini ファイルである
onsite.ini が変更されたことになります。「すべてのメソッドに
特定の user.ini ファイルが割り当てられていない限り、
User.ini ファイルをメソッドに指定してはいけない」という
ルールに従うことが大切です。AMDIS 設定を変更したら、変更後
の設定を Onsite.ini ファイルに保存できます。こうすることに
よって、再び変更を加えない限り、これらの設定が DRS によっ
て引き続き使用されるようになります。

[Open Report] チェックボックスをオンにすると、DRS によって各
データファイルの分析が完了するとすぐに、DRS レポートがデスク
トップに表示されます。多数のサンプルを連続して実行または再処
理する場合を除き、このチェックボックスは通常オンにします。 

DRS の結果を確認するための [Perform NIST Search] チェック
ボックスをオンにする必要がない状況としては、通常 2 つだけ
考えられます。SIN データベースを使用して、それに対応する
SIM メソッドを実行している場合、化合物当たりのイオン数は最
大 4 個になります。4 イオンスペクトルはフルスキャンスペク
トルと一致するとしても、一致の度合いが低いため、NIST 検索
を実行しても意味がありません。通常、NIST ライブラリ検索は、
DRS 分析の中でも最も時間のかかる要素の 1 つです。そのため、
時間を節約するためには、この機能をオフにする必要がありま
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す。ただし実際には、DRS の実行が高速なため、このことが考慮
事項とならないのが一般的であり、スキャンデータに対する
NIST 検索を実行しないラボがほとんどです。

分析の終わりには、DRS レポートのコピーを印刷できます。また、
レポートに含めるグラフィックを印刷することもできます。この
オプションを選択した場合は、検出された各ターゲット化合物の
TIC とグラフィックページが印刷されます。ヒットしたターゲッ
ト化合物ごとに、生のスペクトル、デコンボリューションされた
スペクトル、およびライブラリ一致スペクトルが表示されます

（グラフィックの印刷は AMDIS に基づいて行われますが、NIST
にはこの機能に関連した問題があることがわかっています。修正
パッチが入手可能かどうかについては、Agilent の Web サイト

（www.agilent.com/chem/jp）を参照してください）。

デコンボリューションプロセスでは、スペクトルに所属するかど
うかが不確かな m/z 値が AMDIS によって検出されることが珍し
くありません。AMDIS では、これらのピークを「不確実なピーク」
と呼び、NIST05 質量スペクトルライブラリの検索時にこれらの
イオンを使用するかどうかを選択することができます。ライブラ
リとの一致の質は、不確実なピークが含まれているかどうかい
よって大きく異なる場合があります。SMDIS ライブラリとの一致
率が高い化合物が、NIST ライブラリとの一致率が低い場合は、こ
のチェックボックスをオンまたはオフ（最初の分析と反対の選
択）にして DRS を再実行することによって、NIST05 ライブラリ
との一致率が高くなるかどうかを調べることができます。 

http://www.agilent.com/chem/jp
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適切な設定が選択されたら、[OK] をクリックして最上位に戻り、
コンフィグレーションに加えた変更を保存して終了するか、保存
せずに終了します。
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7
レポートオプション

レポートの生成に関連した設定は ChemStation で確認できま
す。これを行うには、データ解析システムで [Quantitate] > [Report
Options] を選択して、次の図に示す [Quantitation Report Options]
ウィンドウを表示します。

[Omit Target Compounds that] の [Are Missed] チェックボックスと
[Have Qualifiers Out of Range] チェックボックスが共にオンになっ
ていることを確認します。[Global Minimum Detection Limit] チェッ
クボックスをオフにするか、[Minimum Detection Limit] を 0 や
0.010（ng/83μL、第 4 章 で説明したメソッドの場合）などの値
に設定してください。[OK] をクリックして、データ解析システ
ムに戻ります。
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8
AMDIS 設定

通常、DRS を使用する場合、AMDIS はバックグラウンドで実行さ
れるため、分析者が AMDIS に精通している必要はありません。
ただし、AMDIS には、ユーザーによる設定が必要な項目がいくつ
かあります。

Windows の [ スタート ] メニューで [ すべてのプログラム ] > 
[NIST Mass Spectral Database] > [AMDIS_32] を選択して、次の図

のようなウィンドウを表示します。 
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ドロップダウンメニューで [Analyze] > [Settings] を選択して、
[Analysis Settings] ウィンドウ（次の図）を表示します。
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[Identif] タブの [Minimum match factor] を設定する必要がありま

す。0 ～ 99 の値を指定します。ここで指定した値を下回る一致
項目はレポートされず、この値以上の一致項目はレポートされま
す。一般的な推奨値は 60 です。 小さい値を設定するほど誤検出
のリスクが高まり、大きい値を設定するほど見逃しのリスクが高
まります。 

その次の 3 つのチェックボックス（[Multiple identifications per
compound]、[Show standards]、および [Only reverse search]）はオ

フのままにしておく必要があります。

[Type of Analysis] で [Use RI Calibration Data] を選択し、[Use
retention index (RI) for column] チェックボックスをオンにします。

カラムの種類（[Nonpolar] など）には任意の値を指定できます。

Agilent の DRS ソフトウェアでは、化合物の同定にリテンショ
ンインデックス（RI）値ではなくロック済みリテンションタイム
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（秒単位）が使用されます。各ターゲット化合物の検出が予想さ
れる時間帯を絶対的なリテンションタイムで選択する必要があ
ります。リテンションタイムがこの時間帯に含まれない場合は、
ターゲット化合物でないものとみなされ、同定されません。単位
は秒であり、各化合物に対応するデータベースリテンションタイ
ムの左右両側にある時間帯として表されます。上の例では、RI 時
間帯が 10 に設定されており、データベースリテンションタイム
の ± 10 秒以内に収まらないピークは同定されません。この設定
に指定する値は、GC/MS のコンフィグレーションによって異なり
ます。

日本ポジティブリスト農薬データベースのリテンションタイム
は、MHLW のドキュメントで指定されているとおり、30 m ×
0.25 mm × 0.25 μm の DB-5MS カラムを使って取り込まれたも
のです。このメソッドに従って、リテンションギャップや
QuickSwap を使用しない場合は、[RI Window] に値 10 を指定で
きます。リテンションタイムロッキングを定流量モードで実行し
ている場合に、カラムの長さを変更したり、QuickSwap を使用し
たりすると、リテンションタイムが多少シフトします。シフトの
度合いは、クロマトグラムの最初と最後で顕著になります。次の
表に、RI 時間帯の推奨設定を GC/MS のコンフィグレーションご
とに示します。

注入口のメンテナンス時にカラムの大部分を取り除いた場合、早
期溶出または遅延溶出した農薬のリテンションタイムはライブ
ラリリテンションタイムから逸脱します。その場合は、AMDIS 設
定で RI 時間帯のサイズを大きくするか、新しいカラムを取り付
ける必要があります （この状態が起きるのは、メソッドで定流
量カラムが使用される場合だけです。定圧カラムを使用して作成
されたメソッドは常に再ロックできるため、カラムがどの程度取

GC/MS コンフィグレーション RI 時間帯の推奨設定
（秒）

カラムのみ 10

カラム + 5 m × 0.25 mm リテンショ
ンギャップ

10 ～ 15

カラム + 5 m × 0.25 mm リテンショ
ンギャップ + QuickSwap

20 ～ 30
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り除かれたかにかかわらず、すべてのリテンションタイムがライ
ブラリ値と一致します）。

[Match factor penalties] の各設定は、前の図に示すとおりにする

必要があります（無限、100、および 10）。 

[Instrument] タブをクリックして、次の図に示すウィンドウを表

示します。すべてのオプションが次のように設定されていること
を確認してください。

次に、[Deconv.] タブをクリックして [Default] をクリックし、次

の図に示す設定を取得します。これらの設定は DRS の初期値と
して適しています。経験のあるユーザーの方は、[Resolution]、
[Sensitivity]、および [Shape requirements] の値を調整して、ピー

クの同定にどのような影響がもたらされるかをチェックするこ
ともできます。各パラメータと AMDIS に対する影響に関する説
明を表示するには、[Help] をクリックします。 
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デフォルトパラメータの代わりに次の図の設定値を指定するこ
ともできます。これらのパラメータを設定すると、低いながらも
誤検出の起こるリスクがあり、AMDIS でのデコンボリューション
処理が長時間化します。しかしその一方で、デフォルト設定では
見逃す可能性のある農薬を正しく検出できるという利点もあり
ます。
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[Analysis Settings] ウィンドウで AMDIS に関するすべての設定を
選択したら、[Save] をクリックして、Onsite.ini というファイ
ルにパラメータを保存します。[Save As] を使用すると、希望の

ファイルにパラメータを保存できます。ただし、そうすることに
よって Onsite.ini パラメータが変更されるので、実行するメ
ソッドごとに user *.ini ファイルを作成する必要が生じるこ
とに注意してください。

前述したとおりに AMDIS のすべての設定を選択したら、このプ
ログラムを閉じてください。設定の変更が必要とならない限り、
プログラムを再び開く必要はありません。
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Agilent Technologies

9
DRS の実行

DRS ソフトウェアは、ニーズに応じて次の 4 とおりの方法で実
行できます。

1 ドロップダウンメニューの使用して、単一のデータファイルに
対して DRS を実行します。

2 ドロップダウンメニューの使用して、複数のデータファイルに
対して DRS を実行します。

3 ポストランマクロを使用して、各分析の終了時に DRS を実行
します。

4 ポストランマクロを使用して、既存のデータファイルを再処理
します (（注 :  このアプローチはめったに使われないため、
このガイドでは説明していません。詳細については、
ChemStation のヘルプファイルを参照してください）。
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ドロップダウンメニュー項目を使用した DRS の実行

ChemStation データ解析ソフトウェアを開いて、次の図に示すよ
うに [DRS] ドロップダウンメニューをクリックします。このメ

ニューには、DRS を実行するための 4 つのオプション（単一ファ
イルを実行するためのオプション 2 つ、複数ファイルを実行す
るためのオプション 2 つ）が表示されます。

[Quant + DRS single file] または [Quant + DRS multiple files...] を選

択すると、AMDIS デコンボリューションと NIST ライブラリ検索
の前に、指定したファイルに対して定量分析が実行されます。最
終的な DRS レポートには、この新しい定量分析の結果が表示さ
れます。DRS を単一ファイルに対して実行することを選択した場
合は、データ解析システムに現在読み込まれているファイルが分
析されます。複数ファイルに対して DRS を実行することを選択
した場合は、次の図のウィンドウが表示され、分析するファイル
を選択できるようになります。 
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 分析するデータファイルを検索する必要がある場合は、[Change
Path] をクリックします。次に、分析するファイルを左側で強調

表示し、 ボタンをクリックして、次の図のウィンドウに示
すようにファイルを選択します。 
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[Process] をクリックして、選択した 4 つのファイルに対して

DRS を実行します。 
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定量分析をファイルに対して以前に実行したことがあり、満足の
いく結果が得られている場合は、[DRS with existing Quant - single
file] または [DRS with existing Quant - multiple files...] を選択しま

す。このことは、QEdit で定量結果を確認して、ピーク統合に変
更を加えた場合、または DRS によって検出されたが、ChemStation
によって当初定量化されなかったピークを統合した場合に特に当
てはまります。「既存の定量結果を使用した DRS」オプションを選
択すると、ChemStation 定量ルーチンは再実行されず、既存の定量
結果を使用してレポートが生成されます。複数ファイルの選択方
法は、前述の方法と同じです。
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各分析の終了時における DRS の自動実行

GC/MS の実行が終了するたびに DRS を自動的に実行するには、
データ解析の一部として DRS マクロコマンドを実行するように
DRS で指定する必要があります。[Instrument Control] ウィンドウ
で [Method] > [Edit Entire Method] をクリックして、次の図のウィ

ンドウを表示します。

DRS を実行するためのマクロはメソッドのメソッド情報部分で
指定されるので、[Method Information] チェックボックスをオンに

する必要があります。メソッドの他の部分を確認する必要がある
場合は、他の 2 つのチェックボックスをオンにします。[OK] を
クリックすると、次の図に示す [Method Information] ウィンドウ

が表示されます。
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分析が終了するたびに DRS を自動的に実行するには、[Post-Run 
Cmd/Macro] チェックボックスをオンにして、[Data Analysis] に
マクロのパスを入力するか、参照ボタンを使ってファイルを選
択します。マクロは trifecta.mac という名前で、通常は C:\
MSDChem\msexe\trifecta.mac に保存されています。[OK] をク

リックして、メソッドの他の部分の編集を続けるか、編集を終了
します。最後にメソッドを保存することを忘れないでください。
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サンプルファイルに対する DRS の実行

以下の各ステップの実行手順は、前出のトピックで既に説明した
とおりです。不明な点がある場合は、適切なトピックを読み直し
てください。

1 ChemStation データ解析ソフトウェアを開いて、
JAPANPest_2uLSL.m というメソッドを読み込みます。 

2 Strawberry Extract.D というサンプルデータファイルを読み
込みます（C:\msdchem\1\DATA\Strawberry Extract.D）。

3 [DRS] > [Method Configurator] をクリックして、次の図に示す

ライブラリと設定値がメソッド JAPANPest_2uLSL.M に対して
選択されていることを確認します。

4 AMDIS を開いて、次の 2 つの図に示すように分析設定を指定
します。
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5 ChemStation データ解析ソフトウェアで [DRS] > [Quant + 
DRS single file] を選択します。これによって、
ChemStation データ解析に現在読み込まれているファイル

（Strawberry Extract.D）に対して DRS が実行されます。次
の図に示すようなレポートが生成されます。ChemStation の
計算で使用される感度係数は平均値であり、すべての化合物
に対して同一です。そのため、レポートの値は推定値にすぎ
ず、通常は、実際の値の ± 0.1 以内に収まります。
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MSD Deconvolution Report 
Sample Name:  Strawberry extract 
Data File:    C:\msdchem\1\DATA\Strawberry Extract.D 
Date/Time:    04:44 PM  Thursday, Sep 6 2007 
  
The NIST library was searched for the components that were found in the AMDIS target 
library. 
  
      Agilent AMDIS NIST 

R.T. Cas # Compound Name ChemStation 
Amount 
(ng/uL) 

Match R.T. Diff sec. Reverse 
Match 

Hit 
Num. 

11.4914 298022 Phorate 0.99 95 -0.4 90 1 

12.3647 13071799 Terbufos 1.4 97 -0.5 89 1 

12.4698 333415 Diazinon 1.09 95 -0.3 80 1 

12.5726 1517222 Phenanthrene-d10   98 -0.6 84 1 

12.7135 298044 Disulfoton 0.91 87 -0.3 84 1 

14.0851 2032657 Methiocarb   85 0.5 81 1 

14.4553 55389 Fenthion 2.57 99 -0.3 90 1 

16.0453 22224926 Fenamiphos 3.32 96 2.4 88 1 

20.630 96489713 Pyridaben 0.04         

                

12.575   Phenanthrene-d10 5         
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10
DRS 結果の解釈

レポート 1 は、以下の AMDIS パラメータを使用してイチゴのサ
ンプルに関して生成されたものです。

DRS レポートは、同定された各農薬に関する 8 列の情報で構成
されます。 

列 1 クロマトグラムで検出された各化合物について観察され
るリテンションタイム。

列 2 ヒットの Chemical Abstracts Service（CAS）番号。

列 3 農薬名。通常は、農薬について広く使われている一般的な
名前になります。 

列 4 GC/MS ChemStation によって検出された化合物の量。
ChemStation で量をレポートするには、その化合物を較正して、
内部標準（フェナントレン -d10）をサンプルに追加する必要があ
ります。この例では、較正が実行されなかったため、検出量はレ
ポートされていません。第 9 章「DRS の実行」の最後の図は、こ
のイチゴ抽出物の別の分析に基づいています。この分析では、真
の較正値ではなく平均感度係数が含まれている定量データベー
スが使用されました。そのためレポートには、ChemStation に
よって検出された化合物の推定量が示されています。

最小一致率 60

リテンションタイム時間帯 10（± 10 秒）

デコンボリューションパラメータ デフォルト値
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列 5 AMDIS によって生成される値で、デコンボリューションさ
れたスペクトルの日本ポジティブリスト農薬ライブラリに対す
る一致の質を表します。指定可能な最大値は 99 です。最小値は、
AMDIS の [Analyze] > [Settings] > [Identification] タブ > [Minimum
match factor] で 60 に設定されています。デコンボリューション

されたスペクトルのうち、一致率が最小値を下回るものはレポー
トされません。

列 6 この分析で取得された化合物のリテンションタイムと日
本ポジティブリスト農薬データベース内のリテンションタイム
との差異です。値は秒単位でレポートされます。AMDIS の
[Analyze] > [Settings] > [Identification] タブ > [RI Window] でこの
パラメータを選択してあるので、差異が ± 10 秒を上回る化合
物は拒否されます （[Use retention index (RI) for column:]
チェックボックスもオンにする必要があります。このチェック
ボックスをオンにしないと、結果をフィルタするためにリテン
ションタイムが使用されなくなります）。リテンションタイム
ロッキング機能を使用すると、RT 時間帯を狭めて、誤検出を大
幅に減らすことができます。

列 7 デコンボリューションされたスペクトルを NIST 質量スペ
クトルライブラリ検索ソフトウェアに送信して、NIST05 質量スペ
クトルライブラリ全体と比較した結果得られた一致の質です。

列 8 NIST 質量スペクトルライブラリ検索ソフトウェアでは、
検索 1 回当たり最大 100 ヒットがレポートされ、一致率が最も
高いもの（ヒット 1）から最も低いもの（ヒット 100）までが並
べられます。列 8 には、デコンボリューションされたスペクト
ルを NIST05 質量スペクトルライブラリと比較した後で同定さ
れた農薬のヒット番号が示されます。AMDIS によって同定された
化合物が NIST05 ライブラリにおける最良のヒットである場合、
ヒット番号は 1 になります。ただし、スペクトルが非常に類似
している化合物（特に構造異性体）の場合は、必ずしもそうなる
とは限りません。通常、スペクトルが特徴的でない場合や化合物
に複数の異性体がある場合は、1 より大きな値がレポートされま
す。一致の質が良好な場合、ヒット番号は 5 より小さくなるの
が一般的ですが、そうならない場合もあります。  
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前の図のレポート 1 では、AMDIS の一致率が 90 より小さいの
はジスルホトンのみです。AMDIS と NIST05 ライブラリでの一致
率はそれぞれわずか 64 と 69 ですが、リテンションタイムが
データベース値から 0.3 秒しか離れていないため、NIST05 ライ
ブラリ内の最良のヒットとなっています。

図 1 レポート 1

1 2 3 4 5 6 7 8
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AMDIS のデコンボリューションパラメータを次の図のように設
定し、新しい設定値に基づいて DRS をこのサンプルに対して再
実行しました。レポート 2 は、変更後の AMDIS 設定に基づいた
新しい DRS の結果を示したものです。レポート 1 の結果とレ
ポート 2 の結果の間には、違いがほとんどありません。
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次に、下図に示すように [Shape requirements] を [High] に設定

すると、AMDIS におけるジスルホトンの一致率は 77 に改善され
ましたが、NIST05 ライブラリに対する一致率は低下しています

（レポート 3）。

図 2 レポート 2
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図 3 レポート 3
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不確実なピークの包含または除外

クロマトグラム内のすべてのスペクトルをデコンボリューショ
ンするプロセスでは、AMDIS によって成分スペクトルに割り当て
ることができない m/z 値（スペクトルのピーク）が同定される
ことがあります。 AMDIS では、これを「不確実なピーク」と呼び、
NIST05 ライブラリ検索の実行時にこれらのピークを含めるか除
外するかを選択できます。これを指定するには、[Method
configuration settings] ウィンドウ（次の図）で [Use Uncertain
Peaks] チェックボックスをオンまたはオフにします。DRS コン

フィグレーションの表示および編集については、第 6 章「メソッ
ドコンフィグレータの設定」を参照してください。



92 デコンボリューションレポート作成ソフトウェアガイド

10 DRS 結果の解釈
 

レポート 3 と 4 は、[Use Uncertain Peaks] チェックボックスを

レポート 3 でオンにし、レポート 4 でオフにした以外は、同じ
AMDIS 設定を使用して生成されました。2 つのレポートの列 1 ～
6 の出力結果はまったく同じです。不確実なピークが考慮に入れ
られるのは、NIST ライブラリ検索のみです。NIST ライブラリ検
索に関連した列 7 と 8 では、結果が大きく異なっています。不
確実なピークを NIST ライブラリ検索から除外したことによっ
て、7 種類の農薬のうち 6 つの農薬のライブラリ一致率が低下
していることがわかります（レポート 4）。一致率が上昇したの
はジスルホトンだけで、一致率は 57 から 63 に、ヒット番号は
3 から 1 に上昇しました。一方、不確実なピークを使用しない
メチオカルブの一致率は、75 から 59 に低下しています。 

DRS の実行はきわめて容易で、完全に自動化されているため、不
確実なピークを含めた場合と除外した場合の両方で DRS を実行
してみると効果的です。このことは、AMDIS での化合物の同定結
果に確信が持てない場合に特に当てはまります（一致率が低い場
合、RT がライブラリ値から大きく逸脱している場合など）。 
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図 4 レポート 4
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DRS レポートのバリエーション

次の図に示すレポートセグメントには、テブフェンピラドが
AMDIS によって一致率 95 で同定されたことが示されています。
ただし、NIST ライブラリ検索に対応する行には何もレポートさ
れていません。この状態は、ターゲット化合物（この場合はテブ
フェンピラド）が NIST05 質量スペクトルライブラリに含まれて
いないか、化合物が NIST ライブラリの上位 100 ヒットに含ま
れていない場合に生じます。AMDIS での一致率が高い化合物が、
NIST ライブラリに実際に含まれているにもかかわらず、ライブ
ラリの上位 100 ヒットに含まれていないことはめったにありま
せん。この状態が生じた場合は、NIST ライブラリにおけるこの
化合物の最上位ヒットがレポートの次の行に出力されます。この
場合、NIST05 ライブラリでの最良の一致は、一致率 56 の 1H-
インドール -2-カルボン酸、5-エチル-1-(トリメチルシリル)-、
トリメチルシリルでした。農薬がテブフェンピラドであることは
明らかですが、この化合物は NIST05 質量スペクトルライブラリ
に含まれていません。

次のレポートセグメントには、ペルメトリン II が 20.591 分で
検出されたことが示されています。この場合もまた、NIST ライ
ブラリの一致項目は同じ行にレポートされていません。さらに、
ペルメトリン II の列 2 には CAS 番号が出力されていますが、
列 3 では名前の後の中かっこ内に別の番号が出力されいます。
ペルメトリン II の列 2 に示された CAS 番号は架空の番号であ
り（以下の説明を参照）、NIST ライブラリにはこの番号の化合物
が含まれていません。そのため、ペルメトリン異性体の 1 つで
ある、このスペクトルの最良のヒット（シクロプロパンカルボン
酸 ...）がレポートされています。
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AMDIS ソフトウェアでは、「化学物質同定番号」を使用して化合
物が区別されます。最も簡単で一貫性のあるアプローチは、各化
合物の CAS 番号を使用することです。AMDIS のデフォルト設定
では、GC/MS データファイルを分析する際に、各 CAS 番号を 1
回しか使用できません。この設定は一見論理的ですが、各データ
ベースに異なる CAS 番号を割り当てることが必要となります。
AMDIS の [Analyze] > [Settings] > [Identif] を選択して、該当する

チェックボックスをオンにすると、化合物ごとに複数のヒットを
許可できます。ただし、これによって複数のピークに同じ化合物
名が割り当てられるため、紛らわしくなる場合もあります。

複数の幾何異性体または立体異性体を持つ農薬は多く、すべての
農薬に個別の CAS 番号が割り当てられているわけではありませ
ん。さらに、このデータベースでは、農薬異性体の溶出順序がま
だ決定されていません。日本ポジティブリスト農薬データベース
では、同じ農薬の複数の異性体を指定するためにローマ数字が使
用されます。最初に溶出する異性体にはローマ数字 I（1）が割
り当てられ、真正な CAS 番号が付けられます。後続の異性体（II、
III、IV などに指定）には、Agilent によって生成された、一意で
架空の CAS 番号が付けられます。化合物の実際の CAS 番号は、化
合物名の後の中かっこ内に表示されます。たとえば、シフルトリ
ン異性体は、次の表に示すようにデータベースに入力されます。
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複数の立体異性体を持つ化合物を日本ポジティブリスト RTL 農薬
データベースに入力するためのメソッド

RT 化合物名*

* 溶出順序が最も早い異性体は I で識別され、真正な CAS 番号
が割り当てられます。 2 番目以降の異性体には、一意だが架
空の CAS 番号が割り当てられます（次の脚注を参照）。 実際の 
CAS 番号は、化合物名の後の中かっこ内に表示されます。

CAS 番号

† シフルトリン I には真正な CAS 番号が割り当てられていま
す。 シフルトリン II ～ IV に割り当てられた一意の番号は、
最初のハイフンの前に 6 桁があり（合計 9 桁）、先頭に 999 
が付いているという点で、実際の CAS 番号と区別できるよう
になっています。

21.029 シフルトリン I 68359-37-5

21.125 シフルトリン II {CAS 番号 68359-37-5} 999028-03-4

21.184 シフルトリン III {CAS 番号 68359-37-5} 999029-03-7

21.224 シフルトリン IV {CAS 番号 68359-37-5} 999030-03-4
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11
4 つの付属メソッド間の違い

第 4 章「GC/MS メソッドの設定」で説明したとおり、日本ポジ
ティブリスト農薬データベースには 4 種類の GC/MS メソッドが
付属しています。そのうちの 1 つの JAPANPest_6890.M メソッ
ドは、5973 または 5975 MSD と 30 mm × 0.25 mm × 0.25 μm
DB-5MS カラムでコンフィグレーションされた 6890 GC で使用さ
れます。他の 3 つのメソッドは、5973 または 5975 MSD と結合
された 7890A GC で使用されます。最初の 7890A メソッド

（JAPANPest_2uLSL.M）では、農薬分析用に日本 MHLW によって指
定されたすべてのパラメータが使用されています。 

2 番目の 7890A メソッド（RG_JAPANPest_2uLSL.M）では、GC カ
ラムヘッドに接続された 5 m × 0.25 mm の液相なし/不活性化
リテンションギャップに対応するため、多少高めのカラム流量が
必要です。クロルピリホスメチルのリテンションタイムを
13.443 分にロックするには、流量を高めに設定することが必要
となります。

3 番目の 7890A メソッドは、5 m × 0.25 mm のリテンション
ギャップを含み、Agilent の QuickSwap と共に使用するように
設計されています。QuickSwap を使用すると、MSD をベントせず
に、セプタム、ライナー、GC カラムを交換できます。また、分
析が終了するたびに GC をバックフラッシュすることも可能で
す。この処理によって、最後の農薬が排出された後で溶出する高
沸点化合物がすべて除去されます。その結果、各注入の後でカラ
ムがクリーニングされ、クロマトグラフィの質と MSD イオン源
の清潔さが保たれます。QuickSwap を使用すると、MSD に対する
追加流量が発生するので、感度は多少損なわれます。ただし通常
は、メリットがデメリットを上回り、注入量を増やすことによっ
て感度の低下を相殺することができます。
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QuickSwap を使用すると、GC カラムの出口は真空状態でなくな
ります。その代わりに、出口圧力は大気圧より多少（通常は 3 ～
6 psi（20.7 ～ 41.4 kPa））高めに設定されます。これらの変更
の埋め合わせとして、初期の注入口圧力とカラム流量を増やす必
要があります。クロルピリホスメチルのリテンションタイムを
13.443 分にロックするのは依然として簡単です。ただし、この
コンフィグレーションでは、クロマトグラムの最初と最後で農薬
のリテンションタイムが多少シフトします。溶出順序が最も早い
農薬と最も遅い農薬のリテンションタイムは、データベース値か
ら最大 0.15 ～ 0.2 分（9 ～ 12 秒）シフトする可能性があり
ます。この場合に必要となるのは、AMDIS によって使用されるリ
テンションタイム時間帯のサイズを拡大することだけです。たと
えば、次の図に示すように、この時間帯を ± 10 秒から ± 20
秒に広げることができます。このウィンドウの設定については、
第 8 章「AMDIS 設定」で詳しく説明されています。

 



4 つの付属メソッド間の違い 11

デコンボリューションレポート作成ソフトウェアガイド 99

 

次の表に、日本ポジティブリストデータベースに付属の 3 つの
メソッドを使用した 4 化合物のリテンションタイム、および各
メソッドのカラム流量を示します。リテンションギャップを使用
すると、リテンションタイムと流量が多少変化することに注意し
てください。また、QuickSwap を使用すると、ジクロルボスとシ
ペルメトリン I のリテンションタイムが多少シフトします。た
だし、前の図で示したようにリテンションタイム時間帯を AMDIS
で拡大しない限り、このことがメソッドで問題になることはあり
ません。

ジクロルボ
ス

クロルピリホスメ
チル

フェナントレン
-d10

シペルメトリン I 流量

データベース値 6.595 13.443 21.359

JAPANPest_2uLSL 6.595 13.443 12.584 21.359 1.000

RG_JAPANPest_2uLSL 6.607 13.443 12.576 21.359 1.067

QS_RG_JAPANPest_2uLSL 6.728 13.443 12.585 21.234 1.749
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付録 I - 日本ポジティブリスト制度
に関するサイト / 資料

以下の Web リンクおよび学術記事には、残留農薬の日本ポジティ
ブリスト制度に関する詳細情報が掲載されています。サイト / 資
料は、関連トピックごとに次のように分類されます。

1 MHLW メインサイト

a http://www.mhlw.go.jp/english/topics/foodsafety/
positivelist060228/introduction.html

･「食品中に残留する農薬等の基準に係るポジティブリスト
制度について」厚生労働省、2006 年 6 月

b http://www.mhlw.go.jp/english/topics/foodsafety/
positivelist060228/index.html

･「食品中に残留する農薬等の基準に係るポジティブリスト
制度」厚生労働省

2 分析方法

a http://www.mhlw.go.jp/english/topics/foodsafety/
positivelist060228/dl/060526-1a.pdf

･「分野別施策 [ 食品中の残留農薬等 ]（食品中の残留農薬・
動物用医薬品・飼料添加物）」厚生労働省

b http://www.nlfd.gov.tw/dfiles_click.aspx?mtab=
LearnDwl&id=1063&fname=Japan%20methods%20(English%20
version).pdf.

･「食品に残留する農薬、飼料添加物又は動物用医薬品の成分
である物質 の試験法について」厚生労働省医薬食品局食品
安全部 T. Nagayama

http://www.mhlw.go.jp/english/topics/foodsafety/positivelist060228/introduction.html
http://www.mhlw.go.jp/english/topics/foodsafety/positivelist060228/index.html
http://www.mhlw.go.jp/english/topics/foodsafety/positivelist060228/dl/060526-1a.pdf
http://www.nlfd.gov.tw/dfiles_click.aspx?mtab=LearnDwl&id=1063&fname=Japan%20methods%20(English%20version).pdf.
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3 農薬リスト

a http://www.mhlw.go.jp/english/topics/mrls/final/dl/
mrls09.pdf 

･ 暫定的な MRL が設定される化学物質のインデックス

•農薬と薬品を含む（全 709 化合物）

4 MRL 値

a http://www.m5.ws001.squarestart.ne.jp/foundation/
search.html

･「食品に残留する農薬、飼料添加物及び動物用医薬品の限度
量」日本食品化学研究振興財団（検索可能データベース）

b http://www.mhlw.go.jp/english/topics/foodsafety/
positivelist060228/dl/index-1a.pdf

･ MRL リスト（2007 年 2 月 5 日更新）。項目 6（1）の表、
セクション A「食品に関する一般組成標準」、パート I「食
品 : 食品中に農薬成分として使用される物質の最大残留
基準」（MRL リスト）

c http://www.mhlw.go.jp/english/topics/foodsafety/
positivelist060228/dl/index-1b.pdf

･ 暫定的 MRL リスト（2007 年 2 月 5 日更新）

5 検疫所関連の文献 / リスト

a http://www.mhlw.go.jp/english/topics/importedfoods/

･ 輸入食品検査局ホームページ

･「ガスクロマトグラフィ（GC）を使用して 11 農産物で 186
種類の農薬を同定するための 残留農薬一斉スクリーニン
グ方法の検証」J. Health Science、Y. Hirahara 共著、51
(5) 617-627

http://www.mhlw.go.jp/english/topics/mrls/final/dl/mrls09.pdf
http://www.mhlw.go.jp/english/topics/mrls/final/dl/mrls09.pdf
http://www.m5.ws001.squarestart.ne.jp/foundation/search.html
http://www.mhlw.go.jp/english/topics/foodsafety/positivelist060228/dl/index-1a.pdf
http://www.mhlw.go.jp/english/topics/foodsafety/positivelist060228/dl/index-1b.pdf
http://www.mhlw.go.jp/english/topics/importedfoods/
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6 ポジティブリスト制度施行以降の日本における食品の安全に
かかわる違反事例の報告書

a http://www.fas.usda.gov/gainfiles/200703/146280598.pdf

･「2007 年の日本における動植物検疫 /食品安全性の MRL 違
反に関する最新情報」Rachel Nelson & Suguru Sato、米国
大使館

b http://www.mhlw.go.jp/english/topics/importedfoods/

･ 輸入食品検査局ホームページ

•輸入届出における最近の食品衛生法違反事例（7）（Flash）
（2006 年 6 月～ 2006 年 9 月）
（2006 年 10 月～ 2006 年 12 月）
（2007 年 1 月～ 2007 年 3 月）

http://www.fas.usda.gov/gainfiles/200703/146280598.pdf
http://www.mhlw.go.jp/english/topics/importedfoods/
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付録 II -  QuickSwap をインス
トールした場合の日本ポジティブリ
スト農薬メソッドの実行

QuickSwap の利点

Agilent の QuickSwap は、GC カラムの出口と MSD トランスファ
ライン間のパージ付きインターフェースです。QuickSwap を使用
すると、分析者は以下を行うことができます。

1 MSD をベントせずに注入口ライナーとセプタムを交換する。

2 MSD をベントせずに GC カラムのフロントエンドをクリップ
する。

3 MSD をベントせずに GC カラムを交換する。

4 分析の終わりに GC カラムをバックフラッシュして、高沸点の
共抽出化合物をカラムヘッドから除去する（注 :  バックフ
ラッシュを効率的に行うには、通常、MSD に標準ターボポンプ
または拡張ターボポンプを装備する必要があります）。

QuickSwap の唯一の欠点は、パージガスが追加された結果、感度
が多少損なわれることです。
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QuickSwap を使用する場合のカラム流量の調整

QuickSwap では、MSD トランスファライン内のリストリクタにカ
ラム流出液を押し流すために、GC カラムの終端で小流量のパー
ジガスを生じさせる必要があります。このため、カラム出口は加
圧され、真空状態にはなりません。Agilent の GC メソッド変換
ソフトウェア（次の図を参照）を使用すると、同じ検体リテン
ションタイムを維持するために必要な新しいカラムヘッド圧を
計算できます。 

元の条件は、[Original Method] セクションに表示されます。
[Translated Method] は、カラム出口圧力がゼロでなくなり、
19.896 psi（137.2 kPa）（絶対値）になった点で異なります （出
口圧力は機器によって異なる場合があります。QuickSwap 機器で
は、メソッドに適した出口圧力を決定できます）。変換後のメソッ
ドでも同じリテンションタイムを維持するには、変換後のメソッ
ドに対して同じホールドアップ時間を設定します。他のパラメー
タを同じままにすると、新しいカラム流量は 1.9629 mL/min に
設定されます。QuickSwap を使用するときに、RTL ソフトウェア
を使用してこの流量をメソッドに入力して、新しいリテンション
タイムロッキング較正データを取り込みます（第 5 章「リテン
ションタイムロッキング」を参照してください）。クロルピリホ
スメチルのリテンションタイムを 13.443 分に設定して、メソッ
ドをロックします。
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日本ポジティブリスト農薬データベースには、QS_RG_JAPANPest_
2uLSL.M というメソッドが用意されています。このメソッドは、
30 m × 0.25 mm × 0.25 μm DB-5MS GC カラムのヘッドに接続さ
れた 5 m の液相なしリテンションギャップを使用して作成された
ものです。GC/MSD は QuickSwap を使用してコンフィグレーション
され、QuickSwap の圧力は 5.2 psig（35.88 kPa）に設定されまし
た。このコンフィグレーションをコピーし、メソッドのリテンショ
ンタイムロッキングデータを使用して、メソッドを再ロックする
こともできます。メソッドを再ロックする場合は、クロルピリホ
スメチルのリテンションタイムを 13.443 分に設定してください。
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QuickSwap を使用した GC カラムのバックフラッシュ

クリーニングを徹底的に行っても、食品抽出物の汚れはしつこく
残っている場合があります。高沸点の準揮発性化合物は、カラム
ヘッドに蓄積する傾向があり、クロマトグラフィの劣化につなが
ります。従来からの解決策は、分析の終了時にカラムの焼き出し
を行い、クロマトグラフィの質が許容レベルを下回ったらカラム
のフロントエンドをクリップすることでした。 

QuickSwap を使用すると、分析の終了時に QuickSwap の圧力を
上げ、注入口の圧力を下げることによって、カラムをバックフ
ラッシュできます。これによって、キャリアガスが逆流し、溶出
順位の遅い化合物がカラムフロントからスプリットベントに排
出されます。
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バックフラッシュ計算機

7890A/5975 GC/MS を制御するための Agilent ChemStation
（G1701EA バージョン E.01.00 以上）には、バックフラッシュ計
算機が備わっており、メソッドに適したバックフラッシュを簡単
に設定できます。[GC Edit Parameters] で、バックフラッシュアイ
コン（次の図の丸で囲んだアイコン）をクリックして、各注入口
の GC コンフィグレーションを表示します。  

コンフィグレーションには MSD が含まれているので、MSD で使
用される高真空ポンプの種類（拡張ターボポンプ、標準ターボポ
ンプ、またはディフュージョンポンプ）を指定する必要がありま
す。これらのポンプは、それぞれポンプ容量が異なります。ド
ロップダウンメニューで適切なオプションを選択してください。
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[Evaluate] をクリックして、バックフラッシュ計算機を表示しま
す。 計算機には以下の項目が表示されます。

1 ポストランオーブン温度（選択した場合）または GC ラン終了
時の温度。

2 GC/MS トランスファライン温度。

3 使用する検出器の種類。 この場合は、真空状態の MSD です。

4 一般的に検出器に対して許容されている最大流量。 この MSD
には拡張ターボポンプが使用されているので、75 mL/min の流
量に対応できます。

5 許容圧力は、検出器に対して許容されている最大流量によって
決まります。 この場合は、バックフラッシュ時の 130.65 psi

（900.8 kPa）の圧力によって、MSD に対する拡張ターボポンプ
の許容最大流量である 75 mL/min が生成されます。 この値を
下回る圧力であれば許容されます。

6 現在選択されているバックフラッシュ圧力での MSD に対する
流量。 この流量は許容最大流量を大きく下回ります。

7 バックフラッシュ時の GC 出口における圧力。 この圧力は、
QuickSwap に接続された Aux EPC モジュールまたは空気圧制
御モジュール（PCM）によって生成されます。

8 バックフラッシュ時の注入口圧力。 GC カラムの出口圧力を 
80 psi（551.6 kPa）、注入口圧力を 1 psi（6.895 kPa）にす
ると、カラム内のフローが逆流します。

9 取り付けられたカラムに現在の条件（バックフラッシュ圧力 =
80 psi（551.6 kPa）、注入口圧力 = 1 psi（6.895 kPa）、バッ
クフラッシュ時間 = 3.4242 分、オーブン温度 = 300 ℃）を
適用すると、バックフラッシュによって 5 Vo でカラム流出液
が押し流されます。

10 バックフラッシュにかかる期間。 バックフラッシュはポスト
ラン時に行われるので、これはポストランタイムになります。
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最適なバックフラッシュ条件は分析対象サンプルの種類によっ
て異なりますが、以下のガイドラインに従うと効果的です。

1 通常、カラムをバックフラッシュして、すべての高沸点残留物
を完全に取り除くには、少なくとも 5 Vo が必要です。

2 ポストランタイムに GC のオーブン温度を上昇させると、バッ
クフラッシュが高速化します。 オーブン温度を分析の最終温
度より 10 ～ 15 ℃ 高くすると効果的です。ただし、カラム
の推奨最大温度を上回らないように注意してください。

3 MSD に標準ターボポンプが装備されている場合、推奨最大流量
は 25 mL/min です。流量をこの値より下げるには、バックフ
ラッシュ圧力を調整する必要があります。

 

1 2 

3 4 5 6 

7 

8 

9 10 
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4 MSD にディフュージョンポンプが装備されている場合、推奨最大
流量はわずか 4 mL/min です。この流量を多少（最大約 8 mL/min）
上回っても問題ありませんが、最大バックフラッシュ圧力が大
きく下がるため、バックフラッシュにかかる時間は大幅に長く
なります。 カラムを効率的にバックフラッシュするには、MSD
のターボポンプのいずれかを選択する必要があります。

次の図に、カラムを温度 315 ℃、圧力 80 psi（551.6 kPa）で
4 分間バックフラッシュする場合の条件を示します。 メソッド
と GC/MSD システムの要件を満たすバックフラッシュ条件を選
択したら、[OK] をクリックします。
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バックフラッシュ条件の要約が表示され、問題のある箇所が強調
表示されます。 [OK] をクリックして続行し、メソッドに必要な
変更を加えます。 メソッドを保存します。
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1- ナフタレン酢酸

2-(1- ナフチル )アセトアミド

2,6- ジクロロベンズアミド

2,6- ジクロロベンゾニトリル

4,4'-ジクロロベンゾフェノン

アセフェート

アセタミプリド

アセトクロール

アシベンゾラル -S- メチル

アクリナトリン

アラクロール

アルドリン

アリドクロール

アメトリン

アミトラズ

アミトロール

アニロホス

アラマイト I

アラマイト II

アトラジン

アザコナゾール

アザメチホス

アジノホスエチル

アジンホスメチル

アゾキシストロビン

バーバン

ベナラキシル

ベンダイオカルブ

ベスロジン

ベンフレセート

ベノキサコール

ベンチオカーブ

BHC アルファ異性体

BHC ベータ異性体

BHC デルタ異性体

ビフェノックス

ビフェントリン

ビオレスメトリン（アレスリン
2）

ビオレスメトリン

ビフェニル

ビテルタノール I

ビテルタノール II

ボスカリド（ニコビフェン）

ブロマシル

ブロモブチド

ブロモホス

ブロモホスエチル

ブロモプロピレート

ブロムコナゾール I

ブロムコナゾール II

ブピリメート

ブプロフェジン

ブタクロール

ブタフェナシル

ブタミホス

ブチレート

カズサホス

カフェンストロール

カプタホール

キャプタン

カルバリル

カルベタミド

カルボフラン

カルボフラン -7- フェノール

カルボフェノチオン

カルボスルファン

カルボキシン

カルフェントラゾンエチル

キノメチオナート

クロルベンシド

クロルブファム

クロルエトキシホス

クロルフェナピル

クロルフェンソン

クロルフェンビンホス（E）

クロルフェンビンホス（Z）

クロリダゾン（ピラゾン）
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クロルメホス

クロルニトロフェン

クロルベンジレート

クロロネブ

クロロプロピレート

クロロタロニル

クロルプロファム

クロルピリホス

クロルピリホスメチル

クロルタールジメチル

クロルチオホス

クロゾリネート

シニドンエチル

シンメチリン

cis- クロルデン

クロジナホッププロパギル

クロマゾン

クロメプロップ

クロキントセットメキシル

クマホス

ピリミジン

シアナジン

シアノフェンホス

シアノホス

シクロエート

シフルフェナミド

シフルトリン I

シフルトリン II

シフルトリン III

シフルトリン IV

シハロホップブチル

シハロトリン（ガンマ）

シハロトリン I（ラムダ）

シモキサニル

シペルメトリン I

シモキサニル II

シモキサニル III

シモキサニル IV

シブロコナゾール

シプロジニル

シロマジン

デルタメトリン

デメトン -S- メチル

デスメディファム

ジアリホール

ダイアレート I

ダイアレート II 

ダイアジノン

ジクロフェンチオン

ジクロフルアニド

ジ ク ロ フ ル ア ニ ド 代 謝 物
（DMSA）

ジクロルミド

ジクロルボス

ジクロブトラゾール

ジクロシメット I

ジクロシメット II

ジクロホップメチル

ジクロラン

ジクロトホス

ディルドリン

ジエトフェンカルブ

ディフェノコナゾール I

ディフェノコナゾール II 

ジフルフェニカン

ジメピペレート

ジメタメトリン

ジメテナミド

ジメチピン

ジメチリモール

ジメトエート

ジメトモルフ -(E)

ジメトモルフ -(Z)

ジメチルビンホス (E)

ジメチルビンホス (Z)

ジノテルブ

ジオキサベンゾホス（サリチオ
ン）
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ジオキサチオン

ジフェナミド

ジフェニルアミン

ジスルホトン

ジスルホトンスルホン

ジタリムホス

ジチオピル

ジウロン

エディフェンホス

エンドスルファン（アルファ異
性体）

エンドスルファン（ベータ異性
体）

硫酸エンドスルファン

エンドリン

EPN

エポキシコナゾール

EPTC

エスプロカルブ

エタルフルラリン

エチオン

エトフェンプロックス

エトフメセート

エトプロホス

エトキシキン

エチクロゼート

エトベンザニド

エトキサゾール

エトリジアゾール

エトリムホス

フェンアミドン

フェナミホス

フェナリモル

フェンブコナゾール

フェンクロルホス

フェンヘキサミド

フェニトロチオン

フェノブカルブ

フェノチオカルブ

フェノキサニル

フェノキサプロップエチル

フェノキシカルブ

フェンプロパトリン

フェンスルホチオン

フェンチオン

フェンバレレート I

フェンバレレート II 

フェプロピモルフ

フィプロニル

フラムプロップメチル

フルアクリピリム

フルアジナム

フルシトリネート I

フルシトリネート II 

フルジオキソニル

フルフェナセット

フルフェンピルエチル

フルミクロラックペンチル

フルミオキサジン

フルオメツロン

フルキンコナゾール

フルリドン

フルシラゾール

フルチアセットメチル

フルトラニル

フルトリアホール

フルバリネート -I

フルバリネート -II

ホルペット

ホノホス

ホルモチオン

ホスチアゼート I

ホスチアゼート II 

フラメトピル

フラチオカルブ

フリラゾール

ハルフェンプロックス

ヘプタクロル
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ヘプタクロル-エポキシ異性体
B

ヘキサクロロベンゼン

ヘキサコナゾール

ヘキサジノン

ヘキシチアゾックス分解生成
物

イマザリル

イマザメタベンズメチル I

イマザメタベンズメチル II

イミベンコナゾール

イミベンコナゾール-脱ベンジ
ル体

インダノファン

インドキサカルブ

イプロベンホス

イプロジオン

イプロバリカルブ I

イプロバリカルブ II 

イサゾホス

イソカルボホス

イソフェンホス

イソフェンホスオキソン

イソプロカルブ

イソプロチオラン

イソキサジフェンエチル

イソキサチオン

クレソキシムメチル

ラクトフェン

レナシル

レプトホス

リンデン

リヌロン

マラチオン

MCPB メチルエステル

メカルバム

メフェナセット

メフェンピルジエチル

メパニピリム

メプロニル

メタラキシル

メタクリホス

メタミドホス

メチダチオン

メチオカルブ

メトプレン I

メトプレン II 

メトキシクロル

メチルパラチオン

メトラクロール

メトミノストロビン（E）

メトミノストロビン（Z)

メトリブジン

メビンホス

モリネート

モノクロトホス

モノリニュロン

ミクロブタニル

ナレド

ナプロアニリド

ナプロパミド

ニトラリン

ニトロフェン

ニトロタールイソプロピル

ノルフラゾン

o,p'-DDT

オメトエート

オリザリン

オキサベトリニル

オキサジアゾン

オキサジキシル

オキサミル

オキシカルボキシン

オキシデメトンメチル

オキシフルオルフェン

p,p'-DDD

p,p'-DDE

p,p'-DDT

p,p'-Dicofol
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パクロブトラゾール

パラチオン

ペンコナゾール

ペンシクロン分解生成物

ペンジメタリン

ペントキサゾン

ペルメトリン I

ペルメトリン II 

ペルセン

フェナントレン -d10

フェノトリン I

フェノトリン II

フェントエート

ホレート

ホサロン

ホスメット

ホスファミドン I

ホスファミドン II 

フタリド

ピコリナフェン

ピノキサデン

ピペロニルブトキシド

ピペロホス

ピリミカルブ

ピリミホスメチル

プレチラクロール

プロベナゾール

プロクロラズ

プロシミドン

プロフェノホス

プロヒドロジャスモン I

プロヒドロジャスモン II 

プロメカルブ

プロメトリン

プロパクロル

プロパニル

プロパホス

プロパキザホップ

プロパルギット

プロパジン

プロファム

プロピコナゾール -I

プロピコナゾール -II 

プロポキスル

プロピザミド

プロチオホス

ピラクロホス

ピラフルフェンエチル

ピラゾホス

ピラゾキシフェン

ピレトリン I

ピレトリン II

ピリブチカルブ

ピリダベン

ピリダフェンチオン

ピリフェノックス I

ピリフェノックス II 

ピリフタリド

ピリメタニル

ピリミジフェン

ピリミノバックメチル（E）

ピリミノバックメチル（Z）

ピリプロキシフェン

ピロキロン

キナルホス

キノクラミン [ACN]

キノキシフェン

キントゼン（ペンタクロロニト
ロベンゼン）

キザロホップエチル

レスメトリン

S,S,S- トリブチルトリチオホ
スフェイト

シラフルオフェン

シマジン

シメコナゾール

シメトリン

スピロジクロフェン

スピロキサミン I
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スピロキサミン II 

サルフォテップ

スルプロホス

スウェップ

TCMTB

テブコナゾール

テブフェンピラド

テブチウロン

テクナゼン

cis- テフルトリン

ターバシル

テルブカルブ

テルブホス

テルブトリン

テトラクロルビンホス

テトラコナゾール

テトラジホン

テトラメトリン I

テトラメトリン II 

テニルクロール

チアベンダゾール

チアゾピル

チフルザミド

チオメトン

トルクロホスメチル

トルフェンピラド

トリルフルアニド

トリルフルアニド代謝産物
（DMST）

trans- クロルデン

トリアジメホン

トリアジメノール I

トリアジメノール II 

トリアレート

トリアゾホス

トリクラミド

トリクロロホン

トリシクラゾール

トリデモルフ（4- トリデシル）

トリフロキシストロビン

トリフルミゾール

トリフルラリン

トリチコナゾール

ユニコナイゾール -P

バミドチオン

ビンクロゾリン

XMC（3,4- ジメチルフェニル N-
メチルカルバメート）

XMC（3.5- ジメチルフェニル N-
メチルカルバメート）

ゾキサミド

ゾキサミド分解生成物
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